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Pour me contacter

Doctorante en Economie a PSE en 4éme année

Champs de recherche: économie de la famille, de 'éducation, du travail

Pour me contacter, si vous avez des questions ou envie/besoin de parler:
florentine.oliveira@psemail.eu

Campus Jourdan, Bureau R4-54
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Objectifs du cours

e Se familiariser avec

o les techniques @conomeétriques de base
o la recherche en économie empirique

e Apprendre le language de programmation R

— pour pouvoir réaliser votre mémoire !
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Roadmap

Semestre 1

1. Séance 1 (aujourd'hui): Rappels de Rr
2. Séance 2 (18/11/2025): ET'EX et R Markdown
3. Séance 3 (02/12/2025): Régressions Linéaires et Causalité

Semestre 2

1. Séance 4 (TBC - 03/02/2026): Variables de Controle et Matching

2. Séance 5 (TBC - 17/02/2026): Méthode des Variables Instrumentales
3. Séance 6 (TBC - 03/03/2026): Méthode des Doubles-Différences (DiD)
4. Séance 7 (TBC - 17/03/2026): Regression Discontinuity Design (RDD)
5. Séance 8 (TBC - 31/03/2026): Q & A
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Validation du cours

DM

Objectif: manipulation de données sur R, intuition, quelques régressions
A faire seul(e) ou a deux

A rendre pour le 4 Janvier 2026 a 23h59 maximum

Memoire
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Cette seance

1. La recherche en économie empirique
2. R: Rappels

2.1. Définition, usages, interface

2.2. Projet R

2.3. Importer des données

2.4. Manipulation des données avec dplyr
2.5. Visualisation des données avec ggplot
2.6. Maps
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1. La recherche en économie empirique




Qu'est-ce que la recherche en économie empirique?

e Répondre a des questions de recherche pour apprendre sur les comportements humains, l'efficacité des poliques
publiques, ...

o

Quel est l'effet des bourses de scolarité sur la réussite scolaire?

Quel est l'effet d'un allongement de la durée du congé parental sur la participation au marche du travail des meres?
Quelle est 'ampleur de la discrimination dans le processus de recrutement?

Quel est l'effet d'un assouplissement des conditions d'eligibilité a l'assurance chomage sur l'emploi?

Quel est l'effet de la pollution atmospherique sur la productivité?

Quel est le role des medias sur le comportement de vote?

Quel est l'effet de la densité de population sur les salaires?
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Qu'est-ce que la recherche en économie empirique?

Répondre a des questions de recherche pour apprendre sur les comportements humains, l'efficacité des poliques
publiques, ...

o Grande diversité des champs de recherche: éducation, travail, famille, environnement, macroéconomie, politique,
migration, genre, urban, crime, économie historique, ...

o .. en utilisant des techniques statistiques rigoureuses (= @conomeétrie) ...
e .. Une stratégie/un cadre qui nous permet d'identifier un effet causal...

e .. etdesdonnees!

R est un logiciel qui permet de réaliser ces analyses descriptives et empiriques

9/ 68



2. B: rappels




2.1. Définition, usage, interface
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Définition

D'apres le site internet de R : R is a free software environment for statistical computing and graphics.
o un logiciel (interface R studio)

o un language de programmation

R est gratuit et en open source

o donc tres utilise dans les milieux acadéemique et institutionnel

Logiciel tres polyvalent

o statistiques decriptives, analyses econometriques, analyse de données spaciales, ML, Rmarkdown

Compétence valorisée et de plus en plus recherchée (public & privé)
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Interface
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2.2. Projet R
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Projet R

Les projets R permettent une meilleure organisation de votre travail.

e
pratiques-de-la-recherche

pratiques_de_la_recherche.Rproj

Lecture 1

-_—

Data

-_—

— Scripts

-—

e Output

~ Lecture?2

_ Lecture3

—_—

EtC Data

-_—

— Scripts

-

S —— Output

Création d'un projet R:
e Dans R-Studio

o Fichier — Nouveau projet
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Application: creer votre projet r

—

pratiques-de-la-recherche

e Créer un projet R pour le TD en respectant cette

ratiques_de_la_recherche.Rproj
pratiques_de_{a_ pro) structure

Lecture 1 e Créer un nouveau script R dans le dossier Lecture
1/scripts, appelé lecture_1

— Data

———  Scripts

— Output

Lecture 2

ea—,

Lecture 3

Etc — Data

———  Scripts

— Output
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2.3. Importer des données
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Importer des données au format externes

Format .csv:

e read.csv() OU read.cvs2() avec l'argument sep = ';'
Formats .dta (stata), .sas7bdat (sas): package haven (nb: haven estinclus dans tidyverse)
e .dta : read dta()

e .sas7dbat : read_sas()

Format .xls ou .xlsx (Excel): package readxl

e read _excel()
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Importer des données R

Format .rds: format de données le moins lourd et optimal pour travailler sur R, surtout quand les bases de données sont tres
volumineuses

e readRDS()

Conseil: a la fin du script de cleaning, enregistrer le ou les data.frames nettoyés en format .RDS avec la fonction saveRDS() et
importer ces données nettoyées dans le script sur lequel vous ferez toutes vos analyses.
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2.4. Manipulation des donnéees avec dplyr
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Package dplyr

Principal package pour la manipulation de données : dplyr

data.frame %>% function(your action)
——

pipe

Principales fonctions

e mutate():créer ou modifier des variables

e summarise():resume les données par des statistiques descriptives

e filter():conserve ou supprime les lignes

e group_by(): permet de grouper des observations entre elles

e select():conserve ou supprime des colonnes

e arrange():ordonne les observations par rapport aux valeurs d'une colonne
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Opérateurs

Opérateur arithmeétiques

Description

Opérateur logiques

Description

e

Addition / Soustraction

[ >

N

Strictement inférieur / supérieur a

x [/

Multiplication / Division

<=/ > =

Supérieur / inférieur ou égal a

AN

Exposant

Egal a

Different de

X %in% c(1,6)

x dans {1,6}

X

gy

x ety

|y

X

x ouy
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titanic = as.data.frame(Titanic)

head(titanic)




Application : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

2) Créer une variable passenger quivaut1si l'individu n'est pas un membre d'équipage (crew), 0 si c'est un membre
d'équipage

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant
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Solution : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

titanic %>%

TEEETETET

group_by(Class) %>%
summarise(tx_survie

ungroup()

# A tibble: 4 x 2
Class tx_survie
<fct> <dbl>

1 1st 0.625

2 2nd 0.414

3 3rd 0.252

4 Crew 0.240

sum(Freq[Survived B= "Yes"])/sum(Freq)) %>%
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Solution : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

titanic %>%
group_by(Sex) %>%
summarise(tx_survie = sum(Freq[Survived B= "Yes"])/sum(Freq)) %>%

ungroup()
Bt # A tibble: 2 x 2
H# Sex tx_survie
Bt <fct> <dbl>
Bt 1 male 0.212
H# 2 Female 0.732
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Solution : Titanic

1) Calculer le taux de survie par classe, par sexe, et par age

titanic %>%
group_by(Age) %>%

summarise(tx_survie

ungroup()

# A tibble: 2 x 2
Age  tx_survie

TEEET

<fct> <dbl>
1 Child 0.523
2 Adult 0.313

sum(Freq[Survived B= "Yes"])/sum(Freq)) %>%
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Solution : Titanic

2) Créer une variable passenger quivaut1si l'individu n'est pas un membre d'équipage (crew), 0 si c'est un membre
d'équipage

titanic %>%
mutate(passenger = ifelse(Class @& "Crew", 1, 0))

titanic %>%
mutate(passenger = case_when(Class @& "Crew" ~ 1,
Class Bz "Crew" ~ 0))

Conseil: utiliser case_when quand ily a plus d'une condition
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Solution : Titanic

3) Créer une table qui réesume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%
filter(Age Bz "Adult") %>%
group_by(Class, Sex) %>%
summarise(tx_survie = sum(Freq[Survived Bz "Yes"]) / sum(Freq)) %>%
arrange(desc(tx_survie))
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Solution : Titanic

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%
filter(Age = "Adult") %>%
group_by(Class, Sex) %>%
summarise(tx_survie = sum(Freq[Survived = "Yes"]) / sum(Freq)) %>%
arrange(desc(tx_survie))
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Solution : Titanic

3) Créer une table qui résume, pour les adultes uniquement, le taux de survie par Classe x Sexe et ordonner par ordre
décroissant

titanic %>%

TEEFEHEERREREE

filter(Age

"Adult") %>%

group_by(Class, Sex) %>%
summarise(tx_survie

= sum(Freq[Survived = "Yes"]) / sum(Freq)) %>%

arrange(desc(tx_survie))

# A tibble: 8 x 3
# Groups: Class [4]
Class Sex tx_survie
<fct> <fct> <dbl>
1 1st Female 0.972
2 Crew Female 0.870
3 2nd Female 0.860
4 3rd Female 0.461
5 1st Male 0.326
6 Crew Male 0.223
7 3rd Male 0.162
8 2nd Male 0.0833
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Jointures

e Tres souvent, les données nécessaires a l'analyse sont issues de plusieurs sources
e Joindre deux tables de données peut permettre d'ajouter

o des variables supplémentaires
o des observations supplémentaires

e ['ajout de variables peut se faire sur la base:

o de la position des observations dans les deux jeux de données: binding joints
o relativement aux valeurs d'une ou plusieurs autres colonnes, les clés: mutating joints
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Jointures

Binding joints

O o >» O © »

NA
NA
NA

NA
NA
NA

n -

Binding Rows

00
N
V)
M

bind_rows(a, b):dans une jointure de lignes, les colonnes sont associées a leur nom et
toute colonne manquante est remplacée par NA.
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Jointures

Binding joints
NN
A 1 A T
B 2 B F
C 3 D

Binding Columns

A 1
8 2 +
C 3

A T
B F
D T

bind_cols(a, b):dans une jointure de colonnes, les lignes sont mises en correspondance

en fonction de leur position
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Jointures

Mutating joints

A 1 T
B 2 F
C 3 NA

Left-joint

A 1 A T
B 2 + B F
C 3 D T

left_join(a, b, by = "x1"):pour chaque ligne de a on a ajoute les colonnes de b pour

lesquelles la valeur de la clé x1 est la méme
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Jointures

Mutating joints

A 1 1
B F 2
D T NA

Right-joint

A 1 A T
B 2 + B F
C 3 D T

right_join(a, b, by = "x1"):pour chaque ligne de b on a ajouté les colonnes de a pour

lesquelles la valeur de la clé x1 est la méme
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Jointures

Mutating joints

v0)
N =
-

A 1
B 2
C 3

inner_join(a, b, by

Inner-joint

+
1

"x1"): seules les lignes présentes a la fois dans a et b sont jointes
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Jointures

Mutating joints
Full-joint
A 1 A T
B 2 + B = B
C 3 D if
- x1 | x2 | x3 | full_join(a, b, by = "x1"):toutes les lignes de a et toutes les lignes de b sont jointes
& . U (avec des NA ajoutés si nécessaire) méme si elles sont absentes de l'autre table
B 2 F
C 3 NA
D NA T
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Differents formats de base de donnees

Formats wide et long

Pour rassembler des colonnes et passer en format long: pivot_longer

Cotudent L1 [studont | grade | moan |
A T 2.4 A T
B 105  14.1 — B L 105
c 162 158 c | b 162
A L2 12.4
B L2 14.1
c L2 15.8
b = pivot_longer(a, cols = 2:3, names_to = "grade", values_to = "mean")
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Differents formats de base de donnees

Formats wide et long

Pour disperser des lignes et obtenir un format wide: pivot_wider

L1
L2
L2
L1
L1
L2
L2
L1
L1
L2
L2

OO0 00 W www>»>» >» > >

b = pivot_wider(a, names_from = subject,

Cstucent _grace  sublect |_mean |
G snstos

12.3
macro 10.9
19
macro 13.6
11.2
macro 171
8.2
macro 14.7
12.8
macro 13.5
14.1
macro 13.8

values_ from

mean)

OO0 W w >» >

L1

L1

stucent | rade _statsics
L1

12.3
19
1.2
8.2
12.8
141

10.9
13.6
17.1
14.7
13.5
13.8
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Application : Législatives 2024

Utilisation de 3 bases de donneées:

e resultats au premier tour: resultats-definitifs-par-circonscription-tl.csv
e résultats au second tour: resultats-definitifs-par-circonscription-t2.csv
e population par circonscription en 2019: population_2019.csv

Chaque observation = une circonscription
Les bases de données des résultats aux élections sont en format wide:

e chaque circonscription a un nombre fini de candidats (jusqu'a 19 candidats)

o les informations relatives aux différents candidats (nom, sexe, parti politique, etc) sont renseignées dans différentes
variables

o les variables relatives au méme candidat ont le méme suffixe (eg Nom.candidatl, Nuance.candidatl, ...)
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Application : Législatives 2024

< Encodage du libellé des circonscriptions

head(resultats t1[1:4,c(2,4)])

H# Libellé.département Libellé.circonscription.législative
H# 1 Ain lére circonscription
H# 2 Ain 2éme circonscription
H# 3 Ain 3éme circonscription
H# 4 Ain 4éme circonscription

head(pop_2019)[1:4,]

H# X. Circonscriptions Population.20191ll.hab!.
Bt1 o1 Ain, 1re 122750
Bt 2 2 Ain, 2e 137975
Bt 3 3 Ain, 3e 146110
Bt 4 4 Ain, 4e 128896

Variables Clés: Libellé.département qui comprend uniquement le nom du département, et Libellé.circonscription qui
contient uniquement le numero de la circonscription.
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resultats_tl = resultats_tl %>%
mutate(Libellé.circonscription.législative = gsub("H\D", ""  Libellé.circonscription.législative))

unique(resultats_t1$Libellé.circonscription.législative)




pop_2019 = pop_2019 %>%

separate(Circonscriptions, into = c("Libellé.département", "Libellé.circonscription.législative"), sep = ", ") %>%
mutate(Libellé.circonscription.législative = gsub("H\D", ""  Libellé.circonscription.législative))

unique(pop_2019%Libellé.circonscription.législative)




Application : Législatives 2024

1) Importer les données (nommer les dataframes resultats_t1, resultats_t2 et pop_2019)

2) Effectuer sur chaque jeu de données les opérations nécessaires pour harmoniser l'encodage du libellé de circonscription

e POpP-19: separate(Circonscriptions, into = c("Libellé.département", "Libellé.circonscription.législative"), sep =
||' ||)
 resultats_t1 et resultats_t2 et pop_2019: gsub("H\D", "", Libellé.circonscription.législative)

3) Reformatter resultats t1 et resultats_t2 en format long (chaque observation = un candidat)
4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

5) Ajouter les observations de resultats t2 a resultats_t1 et stocker le tout dans resultats

6) Ne conserver que les observations des candidats élus

7)Joindre pop_2019 a resultats et renommer Population.20191. hab. en pop
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Solution

1) Importer les données

resultats_tl = read.csv("data/resultats-definitifs-par-circonscription-tl.csv", sep = ";", na.strings=c("","NA"))
resultats_t2 = read.csv("data/resultats-definitifs-par-circonscription-t2.csv", sep = ";", na.strings=c("","NA"))
pop_2019 = read.csv("data/population_2019.csv", sep = ";")

2) Effectuer sur chaque jeu de données les opérations nécessaires pour harmoniser l'encodage du libellé de circonscription

resultats_tl = resultats_tl %>%

mutate(Libellé.circonscription.législative = gsub("H\D", ""  Libellé.circonscription.législative))
resultats_t2 = resultats_t2 %>%
mutate(Libellé.circonscription.législative = gsub("H\D", ""  Libellé.circonscription.législative))
pop_2019 = pop_2019 %>%
separate(Circonscriptions, into = c("Libellé.département", "Libellé.circonscription.législative"), sep = ", ") %>%
mutate(Libellé.circonscription.législative = gsub("H\D", ""  Libellé.circonscription.législative))
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long

4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

resultats_tl long = resultats_tl %>%
pivot_longer(
cols = matches(".*j\.[1-91$|.%§\.[11[0-91$"),

names_to = c(".value", "candidate number"),
names_pattern = "(.*)H\.(H\d+)"
) %>%

mutate(tour = 1)

Explication:

e cols = matches(".*\.[1-91$|.%}\.[11[0-91$") : Sélectionne les colonnes dont le nom termine par un point suivi d'un
nombre de 1a 19
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long

4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

resultats_tl long = resultats_tl %>%
pivot_longer(
cols = matches(".*j\.[1-91$|.%\.[11[0-91$"),

names_to = c(".value", "candidate number"),
names_pattern = "(.*)H\.(H\d+)"
) %>%

mutate(tour = 1)

Explications:

e names_to = c(".value", "candidate_number"): définie le nom des nouvelles variables
o .value crée de nouvelles variables dont le nom correspond a ce qui précede le point pour chaque variable ayant un
suffixe numerique
o candidate_number crée une nouvelle colonne qui contient les suffixes numériques (1 a 19) indiquant le numéro du
candidat
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long

4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

resultats_tl long = resultats_tl %>%
pivot_longer(
cols = matches(".*j\.[1-91$|.%\.[11[0-91$"),

names_to = c(".value", "candidate _number"),
names_pattern = "(.*)H\.(H\d+)"
) %>%

mutate(tour = 1)

Explications:

e names_pattern = "(.%)}\.(j\d+)": utilise une expression réguliére pour separer les noms de colonnes en deux parties:
o (.x) capture tout ce qui précede le point et l'assigne a .value
o (M\d+) capture les nombres aprés le point et les assigne a candidate_number
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Solution

3) Reformatter resultats_t1 et resultats_t2 en format long
4) Ajouter une variable tour quivaut1dans resultats_t1 et2 dans resultats_t2

On reproduit les mémes opérations sur resultats_t2 (sauf que cette fois-ci il y a au maximum 4 candidats par
circonscription)

resultats_t2 long = resultats_t2 %>%
pivot_longer(
cols = matches(".*j\.[1-41$"),

names_to = c(".value", "candidate _number"),
names_pattern = "(.%)\.(f\d+)"
) %>%

mutate(tour = 2)
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Solution

5) Ajouter les observations de resultats t2 a resultats_tl et stocker le tout dans resultats
6) Ne conserver que les observations des candidats élus

7) Joindre pop_ 2019 a resultats et renommer Population.20191!H.hab!. en pop

resultats = bind_rows(resultats_tl long, resultats_t2 long) %>%
filter(Elu f= "élu") %>%
left_join(pop_2019 %>% rename(pop = Population.2®191II.hab!.), by = c("Libellé.département", "Libellé.circonscripti
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2.5. Visualisation des données avec ggplot?
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Package ggplot2

ggplot2 est un package R qui permet de visualiser des données sous forme de graphiques

Afin de chainer des opérations, c'est a dire d'ajouter des couches au graphique,

ggplot2

on utilise les + (l'équivalent de %>% avec dplyr)
Pour consturire n'importe quel graphique, il faut:

e une base de donnees
o lier les variables aux élements graphiques (axes, couleurs, tailles) via l'argument aes()
« définir un type de graphique (ligne, point, histogramme, densité, etc)

Structure de base

ggplot(data,
aes(x = x, y = y)) +
geom_point()
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Principales fonctions

e ggplot() : Initialiser un graphique en spécifiant les donneées et les aesthetics
e geom_ : Représente les types de graphiques:

o geom_point() pour un nuage de points

o geom_line() pour des lignes

o geom_bar() pour un histogramme/barplot
o geom_density() pour une densité

e labs() :Ajouter des titres et legendes

e theme() : Personnaliser l'apparence du graphique
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Variable discrete

Nombre de siéges par parti
ggplot(resultats, ieges par parti

aes(x = Nuance.candidat)) +
geom_bar() + 150
labs(
title = "Nombre de sieges par parti",
x = "Parti",
y = "Nombre de siéges") +
theme_minimal() 50

0_-l-_ _-I- — — .

DIV DVC DVD DVG ECO ENS EXDHOR LR REG RN SOC UDI UG UXD
Parti

100

Nombre de sieges
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Variable discrete

resultats %>%
count(Nuance.candidat) %>%
mutate(percentage = n/sum(n)*100) %>%

ggplot(aes(x = Nuance.candidat,
y = percentage)) +
geom_bar(stat = "identity") +
labs(
title = "Proportion de sieges par parti",
x = "Parti",
y = "Proportion de siéges") +

theme_minimal()

La fonction count() compte le nombre d'observation par
groupe Nuance.candidat et stocke cette information dans
une nouvelle variable, n (équivaut a

group_by(Nuance.candidat) %>% summarize(n = n()))

Proportion de siéges par parti

30

n
o

Proportion de sieéges
5

0_-l-_ _-I- — — .

DIV DVC DVD DVG ECO ENS EXD HOR LR REG RN SOC UDI UG UXD
Parti
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Variable discrete

Nombre de sié ri
ggplot(resultats, ombre de siéges par parti

aes(x = Nuance.candidat, fill = Sexe.candidat)) +
geom_bar() +
labs(
title = "Nombre de sieges par parti",
x = "Parti",
y = "Nombre de siéges") +

theme _minimal() + I
- 0 _-.-_ — mmm [ | N E .

theme(legend.position="bottom")

150

100

Nombre de sieges

50

DIV DVC DVD DVG ECO ENS EXDHOR LR REG RN SOC UDI UG UXD
Parti

Sexe.candidat [ Femnin [l mascuLin
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Variable continue

Distribution des votes blancs
resultats %>%

mutate(Blancs = as.numeric(Blancs)/100) %>%

ggplot(aes(x = Blancs)) + 0,02
geom_density() +
labs( % 0on
title = "Distribution des votes blancs", S
x = "Votes blancs (en centaines)", S
y = "Fréquence") + 001

theme_minimal()
0.00

0 20 40 60
Votes blancs (en centaines)
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facet_wrap

resultats %>%
group_by(Nuance.candidat) %>%
count(Sexe.candidat) %>%
mutate(percentage = n/sum(n)*100) %>%
ggplot(aes(x = Sexe.candidat,
y = percentage)) +
geom_bar(stat = "identity") +

labs(
title = "Proportion de sieges par parti"
x = "Parti",
y = "Proportion de siéges") +

facet_wrap( ~ Nuance.candidat) +
theme_minimal()

Proportion de siéges par parti

DVC DVG

100
75
28 [ ] ]

HOR

100
75
50

REG SOC

50
2 - . - I
° - _—

Proportion de siéges

FEMINIMASCULIN

FEMININASCULIN FEMININIASCULIN  FEMINIMIASCULIN
Parti
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2.6. Visualisation des donnees spaciales
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Format de cartes et donnees

L Cartes surR

[ Statiques } [ Dynamiques ]

Format de données

/

N

e

|
N

Tres bonne référence: Géomatique sur R

Shapefiles Raster
\_ J
4 N\ (
sf raster
A v N
‘- \ ‘s
ggmap terra
_ J
e N
terra
_ W,
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https://rcarto.github.io/geomatique_avec_r/

Format de cartes et donnees

Tres bonne référence: Géomatique sur R
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https://rcarto.github.io/geomatique_avec_r/

Package sf

Shapefile: format de fichier geospatial utilisé pour représenter des entités geographiques

« contient des informations sur la forme (polygones, points, lignes) et des attributs.
e composé de plusieurs fichiers .shp, .shx, .dbf, tous nécessaires pour la réalisation de cartes

Une fois importés sur R, les objets sf sont des data.frame dont l'une des colonnes contient des geometries.
head(map[ ’ _C(516)]r3)

Simple feature collection with 3 features and 4 fields

Geometry type: MULTIPOLYGON

Dimension: XY

Bounding box: xmin: -0.595231 ymin: 44.80615 xmax: 5.889757 ymax: 50.7899
Geodetic CRS: WGS 84

FEEEETEETT

ID Code.département code_reg nom_dpt geometry
1 33004 33 75 GIRONDE MULTIPOLYGON (((-0.454946 4!!
2 38001 38 84 ISERE MULTIPOLYGON (((5.805288 45!!
3 59010 59 32 NORD MULTIPOLYGON (((3.058745 SOII
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Realiser une carte en 3 etapes

1. Importer les données

o Le jeu de données qui contient l'information a visualiser
o Les fichiers shapefiles qui contiennent le fond de carte, etc, avec la fonction st_read()
o &:onimporte sur R uniquement le fichier .shp, mais tous les autres fichiers (.shx, .dbf, etc) téléchargés avec le

shapefile doivent étre localisés au méme endroit que le .shp
2. Lier le jeu de données qui contient l'information a visualiser avec les données geographiques

o Pour ajouter de l'information a un fond de carte, il est nécessaire de disposer d'une variable (key) géographique

commune entre les deux fichiers
3. Représenter la carte avec la fonction geom_sf() sur le méme principe que geom_line() par exemple avec ggplot2

o |ci, l'esthétique du graphique (aes ) comprend un nouvel argument, geometry, qui doit étre égal a la variable
contenant les données geographiques
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Application: carte resultats legislatives

Importer les données
1) Importer france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning
2) Renommer code_dpt en Code.département €t num_circ en Libellé.circonscription

3) Modifier la variable code.département: Si le premier caractére est un o, Code.département prend la valeur du deuxieme
caracere. Sinon pas de modification

Joindre les bases de données
4) Ajouter les informations de map a resultats et stocker le tout dans resultats_map

Réaliser une carte
5) Réaliser la carte des résultats des éléctions législatives de 2024

NB: ne pas sélectionner les départements 971, 972, 973, 974, 975, 976, 986, 987, 988, ZX, ZZ qui correspondent aux DROM et qui ne
sont pas sur ce fond de carte
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Solution

Importer les données
1) Importer france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning
2) Renommer code_dpt en Code.département et num_circ en Libellé.circonscription
3) Modifier la variable code.département: Si le premier caractére est un o, Code.département prend la valeur du deuxiéme

caracere. Sinon pas de modification

map = st_read("data/france-circonscriptions-legislatives-2012.shp", quiet = TRUE) %>%
rename(Code.département = code_dpt,
Libellé.circonscription.législative = num_circ) %>%
mutate(Code.département = ifelse(substr(Code.département, 1, 1) H= "@", substr(Code.département, 2, 2), Code.départ
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Solution

Importer les données
1)|n1porter france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning
2) Renommer code_dpt en Code.département et num_circ en Libellé.circonscription
3) Modifier la variable code.département: Si le premier caractére est un o, Code.département prend la valeur du deuxiéme

caracere. Sinon pas de modification

map = st_read("data/france-circonscriptions-legislatives-2012.shp", quiet = TRUE) %>%
rename(Code.département = code_dpt,
Libellé.circonscription.législative = num_circ) %>%
mutate(Code.département = ifelse(substr(Code.département, 1, 1) = "0", substr(Code.département, 2, 2), Code.départ
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Solution

Importer les données
1)|n1porter france-circonscriptions-legislatives-2012.shp, que vous stockerez dans maps

Cleaning

2) Renommer code_dpt en Code.département et num_circ en Libellé.circonscription

3) Modifier la variable code.département : si le premier caractére est un 0, Code.département prend la valeur du deuxiéme
caracere. Sinon pas de modification

map = st_read("data/france-circonscriptions-legislatives-2012.shp", quiet = TRUE) %>%
rename(Code.département = code_dpt,
Libellé.circonscription.législative = num_circ) %>%
mutate(Code.département = ifelse(substr(Code.département, 1, 1) = "0", substr(Code.département, 2, 2), Code.départ
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Solution

Joindre les bases de données
4) Ajouter les informations de map a resultats et stocker le tout dans resultats_map

resultats_map = resultats %>%
left_join(map , by = c("Code.département", "Libellé.circonscription.législative"))
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Solution

Realiser une carte

5) Réaliser la carte des résultats des éléctions législatives de 2024

NB: ne pas sélectionner les déepartements 971, 972, 973, 974, 975, 976, 986, 987, 988, ZX, ZZ qui correspondent aux DROM et qui ne

sont pas sur ce fond de carte

II973II ,

ggplot(resultats_map %>% filter(! (Code.département %in% c("971", "972",
geom_sf(aes(fill = Nuance.candidat, geometry = geometry)) +
theme_minimal() +
scale_fill_manual(values = hcl.colors(14, "Purple-Yellow")) +
labs(title = "Résultats des élections législatives par circonscription",

fill = "Parti") +
theme(legend.position = "bottom",

axis.text = element_blank(),
element_blank(),

axis.ticks
panel.grid

element_blank()) +
guides(fill = guide_legend(nrow = 1))

II974II’

II975II ,

II976II ,

||986|| ,

||987||, ||9
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Solution

Parti . DIV . DVC . DVD . DVG . ECO . ENS . EXD . HOR . LR I:‘ REG D RN D (V] D UG D UXD
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Miscellaneous




Vos 4 meilleurs amis

1. La commande help(.) ou 2.
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exemple
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exemple

3. Internet (stackoverflow):

o VOUS ne serez jamais la premiere personne a rencontrer les problémes auxquels vous faites face
o copier/coller le message d'erreur peut suffire, mais essayez de comprendre par vous méme d'abord
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exemple

3. Internet (stackoverflow):

o VOUS ne serez jamais la premiere personne a rencontrer les problémes auxquels vous faites face
o copier/coller le message d'erreur peut suffire, mais essayez de comprendre par vous méme d'abord

4. ChatGPT: devient de plus en plus performant pour résoudre les problemes de codes.

o L souvent les packages ne sont pas a jour, les fonctions proposées inventées
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Vos 4 meilleurs amis

1. La commande help(.) ou 2.
2. Les cheatsheets

o Exempl

3. Internet (stackoverflow):

o VOUS ne serez jamais la premiere personne a rencontrer les problémes auxquels vous faites face
o copier/coller le message d'erreur peut suffire, mais essayez de comprendre par vous méme d'abord

4. ChatGPT: devient de plus en plus performant pour résoudre les problemes de codes.
o L souvent les packages ne sont pas a jour, les fonctions proposées inventées

& Soyez autonomes: ne demander de l'aide a vos camarades (ou @ moi) uniquement aprés avoir demandé a vos 4 meilleurs
amis!
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Bonnes pratiques

Organisation du travail

Un dossier pour chaque projet de recherche et différents sous-dossiers pour:
e Scripts
o un scripts par tache: cleaning, statistiques descriptives, anlayse empirique
e Data
o .rds
e Figures
e (Admin)

o par exemple les documents relatifs a l'acces a une base de données
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1

Commenter son code pour so

Tryingtounderstandiyourcodelfromllastyear;
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.. et ses collégues’

Types of Headaches

o @

READING SOMEONE ELSE’S
Stress UNCOMMENTED CODE

S




Essayer de ne pas s'énerver]

'apprentissage de R est long et fastidieux, mais les

. rendements sont croissants!
given

error
message onr

[1]: R Memes For Statistical Fiends

"Oh,
it's just
an extra

parenthesis"

CAN'T FIND
ONE SINGLE
PARENTHESIS
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Appendix




Cheatsheets

e R Studio Environment
e All cheatsheets
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https://rstudio.github.io/cheatsheets/rstudio-ide.pdf
https://posit.co/resources/cheatsheets/

~

RStudio IDE :

. CHEATSHEET

Documents and Apps

Open Shiny, R Markdown,
knitr, Sweave, LaTeX, .Rd files
and more in Source Pane

Check Render Choose Configure Insert
spelling output output render code Publish

'
2
L Jumpto Jumip  Rui Showlile Visual
: previous tonext code outline  Editor

7 chunk  chunk (reverse
H side)

» Run

- Jumpto all previous  Run this

code chunks  code chunk

1w section
15
or chunk :
et oy Set knitr
I chunk -
» options
11| (oplows A skdonn o

Access markdown guide at
Help > Markdown Quick Reference
See reverse side for more on Visual Editor

RStudio recognizes that files named app.R,
server.R, ui.R, and global.R belong to a shiny app
S rwonhnd O wed . O A ==
QZF-

1 H
H Run”" Choose ""Publish to - Manage
4 app cha(ionto shinyapps.io publish
.- viewapp  orserver  accounts
op et ¢ Rsoe :

format options  chunk toserver

Package Development

Create a new package with
‘ File > New Project > New Directory > R Package

Lo S st

Source Editor

Navigate Openinnew Save Findand Compileas Run
backwards/ window replace  notebook  selected
forwards 3 ~‘code

Tab Panes

Importdata History of past Manage
withwizard ~ commandsto  external
_‘_,databases usage

rui p/copy

’VTi\Zvr:‘ory Rtutorials Co ntrol

” Go

ok © scrgrh
Sourceonsme O /-

Code diagnostics that appear in the margin.
... Hover over diagnostic symbols for details.
- get_digit <. funtti

1 ¥ Good Start i
2 Re-run « Source with or Show file
i previouscode  w/out Echoor outline

s asalocal Job

g “ea3000 Multiple cursors/column selection

3 “BEeBea03 with Alt + mouse drag.

9 "PORING0s"

i

2

3

' ......Syntax highlighting based
on your file’s extension

Tab completion to finish function
names, file paths, arguments, and more.

- e (${Livariable) (n $(Zivecter)) (
19 |RER]
r

;: * for }

22 L@ force | “Multi-language code snippets to

23 quickly use common blocks of code.
;; Jump to function in file Change file type
B ot : nsire s

Console  Terminal - R Markdown -~ Jobs
@ R4.1.0 - ~/Deskoplapn!

o i Working Ruh scriptsin Maximize,
343 Directory eparate sessions minimize panes
PE

[h Ctrl/Cmd +4 “RMarkdown Dragpane ..

N to see history  Build Log boundaries

Oataser - % 14808 - o
ment « :

Save ClearR
workspace i workspace workspace

Choose environment to display from

History  Conactions  Buile™ " Git  Tutorial

Search inside
environment

Display objécts

list of parent environments as list or grid
Data

Odf 3 obs. of 2 variables

Values

x 1
Functions
foo function (x)

Displays saved objects by Viewin'data View function
type with short description viewer source code
Files  Plots  Packages Help  Viewer -0
Q. Newfolder O Delete = Rename {F More -

%4 wome  Dedhiop G More file x
I o™ options lodnes

Create i Delete Rename “"'::""‘"‘" Change’

y \ PR— i
folder : file file o Yo Warkig Dvscry directory
i _ Pt
Path to displayed direCtory | o rerieses wee
© appr Show thsden sins 110,2021, 6:21 PM
¥ appRproj 3038 Jul 10,2021, 4:51 PM

A File browser keyed to your working directory.

Click on file or directory name to open.

RStudio opens plots in a dedicated Plots pane

RStudio opens documentation in a dedicated Help pane

Tiles  Fots  Packsges Melp  Viewsr

=0
Refresh Help Togic

-

Version

«§=  Turnon at Tools > Project Options > Git/SVN

a 0 Added 0 Modified
O Deleted @ Renamed

Stage Commit  Push/Pull  View
files: s!ggedfiles toremote  History branch

Untracked

Current

niironmant Juatory | Congecions  Sule-CA Twioral H =
2 T CT®- (o beanch -
Open shell to type commands
Show file diff to view file differences
G W] oo vt < 7 o S et © e
aged 3n =rem pr—r—
T e
]
g [ o
oo O e ® Grsoged Conut | Gians 1 G Supeal | Oucd Al
CEwEwTy (St et e
211 a0 5y ettt Yo e o e i by et

Debug Mode

Use debug(), browser(), or a breakpoint and execute
your code to open the debugger mode.

Launch debugger ~ Open traceback to examine
mode from origin  the functions that R called
oferror ™ before the error occurred

Console  Terminal - “Jobs
> helloQ)

Error

=0

" Show Traceback
® Rerun with Debug

add/remove a breakpoint.

Click next to linenumberto  Highlighted line shows wi
execution has paused

here

oy ~
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